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How to Use the Software Cases 
 
 There are five spreadsheet cases in this package.  The cases are graduated in difficulty, both in 
terms of software skills and management skills. The cases are short enough to be answered in one computer 
session lasting no more than one hour for a novice.   
 
 Each case has an estimated completion time. Students are strongly advised not to skip early 
problems. If you skip early problems, you will not learn the software skills required in later cases. This 
will, in turn, lengthen the time required to answer later cases by several hours.    
 
 A Tutorial Documentation section that carefully describes the software skills needed to solve each 
case follows the case. The software skills are demonstrated using a sample spreadsheet file (Course.xls).  
You will find this file on the Student CD ROM in a folder called Student Data Files.   
 
 You should first read the case to understand the nature of the problem.  Then examine the tasks 
you will need to perform to complete the project.  You should then study the Software Tutorial carefully to 
be sure you understand how the software works, and to master the software skills you need to solve the 
case. Finally, you should begin work on the case itself.  
 
 
How to Cope With Ambiguity in Cases 
 
 Because these cases are derived from real world events and circumstances, they often contain 
ambiguities—just like the real world itself. In advanced cases, you will typically find more than one way to 
solve a problem, and you will find that certain assumptions and value judgments must be made to arrive at 
any solution. 
 
 You should first clearly identify the nature of the ambiguity. Then consider the alternative 
solutions. Choose the solution you prefer and specifically state the assumptions and value judgments you 
are making. Be prepared to defend these assumptions, as well as to learn from others who made different 
assumptions.     
 



System Requirements 
 
 These management cases assume that you have access to a personal computer, with a CD ROM 
drive, and with Microsoft Excel installed.  The cases also assume you have the ability to work with the 
Windows operating system.  The cases are developed using Excel 2003, but you can use earlier versions as 
well.  You will also need access to a printer.   
 
 
General Instructions for Working With Student Data Files 
 
1.   Read the case study  to identify the name of the specific data file used in the case. This will also 
provide an overview of the case’s basic issues. On the first page of each case, the appropriate student data 
file is identified.  
 
2.  Start Excel and then open the case study data file required by the case.  The case study file will be 
found on the Student CD ROM in the folder named Student Data Files.   The Student CD ROM must be 
inserted into an appropriate CD ROM drive on the computer you are using.   
 
You are now ready to begin.  

 
Azimuth License Agreement 
 
Carefully read the licensing agreement before using the Student Data Files or student projects. By using the 
data files and cases, you accept the terms of this agreement. This package contains valuable proprietary 
materials of Azimuth Interactive Inc. ("Azimuth"). Azimuth retains the title and ownership of the software, 
including all patent, copyright, trade name, trademark, and other proprietary rights related to the software. 
All written materials are copyrighted. 

Permitted Uses 
The data, programs, and case book included in this package are licensed only for individual use on one or 
several computer systems by the original purchaser. You may make a single backup copy of the files to 
support your use of the package. 

Prohibited Uses 
You may not make the software, or any parts of the package, available to other persons by copying, 
translating, lending, leasing, or selling. This package may not be re-sold as "used” and to do so is a 
violation of federal copyright and software protection laws. The Student Data Files may not be placed on a 
network of any kind without permission of Azimuth. 

Limited Warranty 
Azimuth warrants that the cases and data files on which the software is distributed are free from defects in 
materials and workmanship for a period of 90 days following original purchase.  

Copyright 1992-2007 Azimuth Interactive Inc. 
Printed in the United States of America 
Azimuth Interactive Inc.  
23 North Division Street Peekskill, 
New York 10566 

All rights reserved. No part of this document may be reproduced or transmitted in any form or by 
any means, electronic, or mechanical, including photocopying, or any information and retrieval 
system, without the permission of Azimuth Interactive Inc. 

 



Spreadsheet Management
Software Cases

Spreadsheet Case 1

Supply Depot

Problem: Develop a sales prospect tracking system

Management skills: Organizing
Controlling

Excel skills: Data input
Worksheet formatting
Printing

File: SUPPLY_Q.XLS

Lance Bertram is a sales representative with Supply Depot, an office supply firm located in
Santa Fe, New Mexico. His boss has instructed him to increase sales by 15% by attracting new
customers. Lance locates the names of small businesses by using telephone directories, mailing lists,
and the Internet. He makes a list of these sales prospects, noting the company name, telephone
number, and the owner’s name, if available. Then he starts telephoning them to describe Supply
Depot’s product offerings.

If Lance’s prospects are interested but not ready to purchase, he makes a follow-up call two
weeks later. Sometimes, Lance forgets whether he has called a prospect and calls that person again,
or he forgets to make a follow-up call. Therefore, Lance needs a way to keep track of prospects and
phone calls to which he can easily refer and update.

Load the worksheet file SUPPLY_Q.XLS. This worksheet contains a list of some of Lance’s
sales prospects and their telephone numbers. Use your spreadsheet software to create a prospect
tracking system that Lance can refer to on screen or print out.
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The worksheet should list each prospect’s name, telephone number, and the date of the last
telephone call. It should also include a column for Follow Up in which Lance can enter a Yes or No
to indicate whether a follow-up call is required. To locate names more easily, organize the prospect
list in alphabetical order by last name.

The look and shape of spreadsheets are extremely important if you want to use the
information they contain effectively. Professional-looking spreadsheets are formatted in special ways
so that you can quickly locate and digest their information. The format should allow for easy changes
and updating. This problem shows you how to develop professional-looking, maintainable
spreadsheets.

Tasks

There are 6 tasks to this problem:

1. Create appropriate column headings to capture the required information. There should be
column headings for Last Name, First Name, Telephone, Company, Date Called, and
Follow Up. The column headings for Last Name, First Name, and Telephone already appear
on the worksheet and can be used as models.

2. Create appropriate widths for each column, and then decide whether to left justify, right
justify, or center the column labels. Some of the worksheet columns have already been
widened for you. 

3. Complete the schedule by entering the required information suggested above. The follow-
ing table will be helpful:

Last Name Company Date Called

Anderson Western Arts, Inc. 6/28/04

Evans A & L Office Supply 7/1/04

Flaherty Belltown Freight 7/26/04

Kim Arts & Crafts Store 7/11/04

Steinman Industrial Acquisitions 6/27/04

Suzuki Talent Personnel, Inc. 7/19/04

4. Be sure to enter the dates as labels, not as data. Lance needs to make follow-up calls to
Morris Steinman and Hisako Suzuki.

5. Lance has just found two more prospects. They are Shelly Lewis and Dennis Matthews,
both of whom need follow-up calls. Lewis heads Lewis Gifts and was first contacted on
7/29/04. Her phone number is 415-555-5554. Matthews works for Zynn Transportation and
was first contacted on 7/13/04. His phone number is 415-555-4954. Add information about
these prospects to the prospect list by inserting new rows in the appropriate places in the
worksheet to ensure that the last names remain in alphabetical order.

6. Improve the appearance of the log by underlining column labels. Print a report of the log.
You should be able to print this worksheet on one 8-1/2 x 11-inch page.
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Time Estimates

Expert: 30 minutes

Intermediate: 45 minutes

Novice: 1.5 hours

Excel Tutorial for Spreadsheet Case 1

This case draws upon the data entry skills you have already acquired in developing
Course.xls and upon new skills for formatting and printing spreadsheets. You will need to use
Course.xls again for this tutorial.

How to Retrieve a Data File

Begin by opening Excel again. When the spreadsheet screen appears, your first step will be
to load the data file Course.xls. Do this either by clicking the Open button on the Standard 
toolbar or by accessing the Open command under the pull-down File menu. The Open dialog box
will appear.

The settings within the dialog box may need to be amended to load the file. The four items
that must be set are the File Name, the File Type, the Folder, and the Disk Drive. A list of files of
the type specified for the Disk Drive and Folder appears in the File List window. To change the
settings to retrieve Course.xls, first ensure that Microsoft Excel Files or All Files appears as the
File Type. If it does not immediately appear, it can be changed by clicking the downward pointing
arrow next to the File Type list box, revealing a list of File Types Excel can open. To move up and
down the list, click the arrows on the scroll bars next to the list. Select the required File Type with
the mouse pointer.

Use the Look in list arrow to select the Folder and Disk Drive where Course.xls is stored
and display it in the File Name list. The files are listed alphabetically, so if the desired file is not
visible, you can move down the list using the scroll bar. Double-click the Course.xls file to open it.
Alternatively, you can simply type Course.xls (or just Course) in the File Name box. Typing the three
letter extension to specify your file is optional. When the settings are correct, click the Open button
or press the Enter key.

How to Insert or Delete Columns and Rows

Suppose you wanted to add lines under the column headings in your student roster. You can
insert columns and rows in an Excel worksheet in either of two ways: (a) through the menu command
Insert/Rows, or (b) using the shortcut menu displayed by clicking the right mouse button and
selecting Insert, which presents four options:
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Shift Cells Right

Shift Cells Down

Entire Row

Entire Column

Selecting Entire Row from the options presented and clicking OK inserts a blank row.

A third method is to select an entire row and then select Insert from the shortcut menu, or
by selecting Insert/Cells or Insert/Rows from the menu. To select an entire row, move the mouse
pointer over the row number at the left of the worksheet and press the left mouse button. To select
multiple rows, keep the left button depressed and drag up or down.

You will now insert the blank line into your student roster. To do so, move the worksheet
current cell to the row below the column headings—that is, move to row 7; it doesn’t matter to which
column. Select Insert/Rows from the menu. You will notice that a blank row is inserted in row 7 and
the data previously in rows 7 through 10 is moved to rows 8 through 11. Your worksheet screen now
looks like Figure 3-1. The Insert Options button that appears in Excel 2003 may be used to select
formatting options for the new row. You may ignore the button. 

Figure 3-1



You can delete one or multiple rows and columns using the same principles used in
inserting rows and columns. There are two ways of accessing the Delete command in Excel: (a)
through the pull-down menus located at Edit/Delete, or (b) through the shortcut menu activated by
the right-hand mouse button. If entire rows or columns are highlighted when these commands are
selected, the effects will be immediate: the row(s) or column(s) will disappear at once.

To make the worksheet documentation section conform to the spreadsheet design principles
introduced in Chapter 2, let’s add a fourth line to the documentation section. In cell A4 enter
“Ranges: none Macros: none”. (We will add macros and range names in later tutorials.) Then insert
a row so that there are two rows between the documentation section and the course list itself.

Moving and Copying the Contents of Cells

After using the Insert/Rows command again, you will have a blank Row 8. You can now
add separator lines in this row to further set off the column headings from the data on the list. 

This is a convenient time to explain some commonly used and helpful operations: 
Moving and Copying. A Move is referred to as a Cut in Excel, and simply involves relocating the
contents of one or more cells. A Copy reproduces the contents of the cells. Both Cuts and Copies
must be accompanied by a Paste operation. The Cut or Copy designates from where the cells are cut
or copied, while the Paste designates to where they are being placed.

As with most operations in Excel, there are several ways to cut and copy:

1. Using the Cut, Copy, and Paste functions from the Edit menu

2. Using the Cut, Copy, and Paste functions from the Shortcut menu

3. Using the buttons on the Toolbar for Cut , Copy and Paste

4. Using the keystrokes for Cut (Ctrl-X), Copy (Ctrl-C), and Paste (Ctrl-V)

5. Using the mouse pointer to drag and copy

Each of these is worth exploring at least once, and you can decide which you find the most
convenient. Generally speaking, most users use two of the methods listed. For example, some users cut
and copy within a small area in a spreadsheet using the mouse to drag and copy, and cut and copy
between larger areas and between spreadsheets using one of the other techniques. Once you become
familiar with each method, you will see that they are very similar, and they all require you to specify a
source range of cells, an operation (cut or copy), a destination or target range, and the paste function.

It is worth explaining the mouse method of cutting and copying since it is extremely useful.
This method applies to a single cell or a multiple selection. When you move your mouse pointer to
the border of a selection on the worksheet, it transforms from a white cross to an arrow. This is the
signal that you can now perform the drag or copy.

To drag (or cut) the contents of the selection, depress the left mouse button and move the
mouse, holding the button down. As you move the mouse across the worksheet, a shadow of the
selection will also be moved until the mouse button is released to designate the destination of 
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the drag. This operation may require some practice, but it will become second nature very quickly
and an important editing function.

To perform the mouse copy, the actions are nearly identical to the drag (cut). The mouse
pointer is moved to the border of the selection and the cross turns into an arrow. At this time, press
and hold down the Control key. A small tell-tale cross will appear next to the arrow, indicating that
we are performing a copy rather than a move. Drag the selection as we did for the move; when the
mouse button is released, you will see the copy operation has been completed. With practice, you
will realize that each of the different cut and copy methods results in identical results.

Returning to Course.xls, we now want to insert some decorative separators into the cells in
Row 8 to distinguish the headings from the body of the table. To do this, we will enter the “=” 
(without the quotes) and select the Alignment Fill command to fill the cell width with this symbol.

First, press “=” and click the Enter button on the Formula bar to enter “=” in cell A8.
Now select Format/Cells for the Formatting box to appear. This box has six formatting tabs:
Number, Alignment, Font, Border, Patterns, and Protection. Select Alignment by clicking on the tab
label at the top of the box. In the Horizontal Alignment section, select Fill and then click the OK
button or press Enter. The cell will be filled with the “=” symbol.

Once you have set up the first cell, you can replicate it in all the cells in Row 8 below the
column heads. Do this by using the Edit/Copy command. First, select the Copy command from the
Edit menu. Notice the moving border around cell A8, indicating a copy or cut source. Next, select
cells B8, C8, and D8, referred to as range B8:D8. Do this by moving the mouse pointer to cell B8,
depressing the left mouse button, and dragging to the right until the desired range is selected. Now
select the Paste command from the Edit menu. This will copy the formatting and contents of cell
A8 to the range selected. Your worksheet should look similar to Figure 3-2. In Excel 2003, the Paste
Options button permits you to set formatting options for the data you have just pasted. Since you
do not need to consider additional formatting, you may disregard the button.

Printing Your Worksheet

To print a simple worksheet such as your student roster, which is one page or less, you need
only know the basic printing commands. Select the Print command under the File menu to display
the Print dialog box. The various options in this dialog box can be explored later, however, for our
purposes, simply accept the default settings and click the OK button.

In this case, Excel will just print the page containing the student roster. Features can be
adjusted, including paper size, page orientation, scaling, margin sizes, alignment, header and footer
contents and options, print titles, page print sequence, and print area. You will find these features in
the Page Setup dialog box under the Page Setup command on the File menu (see below). Before
printing, the appearance of your page can be observed in Print Preview under the File menu so
paper need not be wasted.

As Excel is printing your page, a small message box appears stating which page is currently
being printed. This box contains a Cancel button, which you can choose if you want to stop the printing.



Changing Excel’s Printer Options

The printing options in Excel can be changed under File/Page Setup. Four formatting tabs
will appear in the Page Setup dialog box: Page, Margins, Header/Footer, and Sheet.

Under Page, you can decide on features pertaining to individual pages being printed. 
The first option is Orientation—that is, whether the page is printed in landscape (horizontal wide,
vertical narrow) or portrait (horizontal narrow, vertical wide) mode. The second option permits you
to scale the size of the print up or down a specific percentage, or scale to fit a certain number of pages
where the computer determines the percentage scaling. The next option permits you to change the
paper size between various standard sizes (e.g., Letter, Legal, Executive, A4, etc.). The next option
allows you to change the print quality. The final option permits you to specify the starting page of
printing. To print from the start, enter 1 or AUTO; otherwise enter the page number from which you
wish to begin.

Under Margins, you can change the margins that border the pages. The size of the margins
on each page’s edge can be specified in particular units (inches, centimeters). The next option is the
distance between the edge of the page and the header or footer. The last options are whether to center
the print subject horizontally or vertically on the page.

Figure 3-2
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Under Header/Footer, you can change the appearance of the headers and footers of the
printed pages. The operation and options of headers (appearing at the top of every page) and footers
(appearing at the bottom of every page) are the same. Each includes a number of default sample
headers, a list to which you can add. Selecting Custom Header or Custom Footer permits you to
change the header/footer. Each is split into thirds: left, center, and right. In each or any of these
sections, you can enter any text or any of the options offered: current page number, total pages in
print, Current Date, Current Time, and Sheet Name. You can change the fonts of any text using an
available button.

Under Sheet, you can change the print features pertaining to the worksheet. First, you can
specify precisely the range on the worksheet you want to print. This is done by placing the mouse
pointer in the window provided and then highlighting the range on the worksheet. The next option
lets you specify Print Titles, which are either rows or columns that are to appear on every printed
page. These are useful for lists or tables that extend beyond the confines of a single page. The next
group of options contains general purpose ones: Gridlines, Black and white, Draft quality, Row and
column headings, Comments, and Cell errors. The final option is the Page Order—that is, whether
to print down and across or across and down.

Save Course.xls with the changes you made during this tutorial session. You will need it for
the next Spreadsheet Case.



Spreadsheet Case 2

Sampson Clothiers

Problem: Track users and buyers on an e-commerce Web site

Management skills: Organizing

Excel skills: Formulas
Absolute and relative addressing
Worksheet formatting
Printing

File: SAMPSON_Q.XLS

Sampson Clothiers is headquartered in Beaverton, Oregon, and makes casual pants, shirts,
and other clothes for both men and women. They have been in business since 1979 and have 15 store
locations in the western United States. Annual revenue from all the stores has been increasing each
year, with 2003 revenues totaling $9,500,000. Richard Pennell, President of Sampson Outfitters,
recognized the potential market in online sales two years ago and had an outside Web development
firm create an e-commerce site for the company. The site has had moderate success, but Richard
would like to understand more about how customers come to his site and how many visitors to the
site turn into buyers.

The company has been attempting to increase the number of online customers by placing
advertising banners for its Web site at other Web sites. When users click on these banner ads, they
are automatically transported to Sampson’s Web site. Data from the advertising campaign is
summarized in the weekly Marketing Trends Reports (MTR) produced by their Web site analysis
software, which appears in the SAMPSON_Q.XLS file located on your data diskette. 

• Visitors are the number of people who visited Sampson’s Web site by clicking on a ban-
ner ad for their site that was placed on an affiliated Web site.

• Shoppers are the number of visitors referred by banner ads who reached a page in the
Sampson’s Web site designated as a shopping page. 

• Attempted buyers are the number of potential buyers referred by banner ads who reached
a page on the Sampson’s Web site designated as a page for summarizing and paying for
purchases. 

• Buyers are the number of buyers referred by banner ads who actually placed an order on
the Sampson’s Web site. 

• Source indicates the specific Web site from which visitors came to Sampson’s Web site. 

In trying to increase the number of on-line customers, Richard must determine the
company’s Web site’s success in converting visitors to actual buyers. He must also look at the

11                       Management Problem Solving Cases



Spreadsheet Cases 12

abandonment rate—the percentage of attempted buyers who abandon the Web site just as they were
about to make a purchase. Low conversion rates and high abandonment rates are indicators that a
Web site is not very effective. He also must identify likely Web site partners for a new advertising
campaign. 

Tasks

There are 5 tasks to this problem:

1. Create new columns for the percentage of visitors who became shoppers and the percent-
age of attempted buyers who became buyers.

2. Create formulas to total each column so you can easily determine the aggregate number of
Visitors, Shoppers, Attempted Buyers and Buyers .

3. Create formulas to calculate the percentage of Visitors who became Shoppers and
Attempted Buyers who became Buyers. Calculate the percentages on the totals of these
categories as well.

4. Format the spreadsheet so the percentages appear with the percent sign and so all the
column headings appear.

5. Print the spreadsheet. Try to print this spreadsheet on a single page. 

Excel Tutorial for Spreadsheet Case 2

This case draws upon all of the skills acquired in Spreadsheet Case 1, plus new skills for
using formulas, formatting, and absolute and relative addressing. You will need to use Course.xls
again for this tutorial.

Suppose you want to expand your worksheet by including each student’s final grade. 
You must add an extra column and label for FINAL GRADE, and you must calculate the final grade
for each student. The final exam counts for 45% of the final grade, the midterm for 35%, and the quiz
for 20%.

Formulas

To compute the final grade you must use a formula: A formula tells Excel what manipula-
tions to perform on specific cell contents. The cells are specified using their cell references (e.g. A11,
C3). Mathematical operators specify arithmetic operations. They are:



Operations are always performed left to right within a formula in their order of precedence.
The order of precedence in Excel corresponds to the order of the above list. Exponentiation will
always be performed first, followed by multiplication and division, then addition and subtraction.
Percent amounts are evaluated when they are encountered.

Parentheses can be used to override the order of precedence. Operations inside parentheses
will be performed before those outside the parentheses. The order of operations remains the same
within the parentheses. When multiple sets of parentheses are employed, the operations within the
innermost set of parentheses will be performed before those within the next set.

Thus, the formula for James Jackson’s final grade would be:

=B9*.15+C9*.35+D9*.50

or alternatively

=B9*15%+C9*35%+D9*50%

Enter this formula in cell E9. This cell will display Jackson’s final grade. Note that the first
cell in the formula is preceded by a = sign. To be treated as a formula rather than a label, a formula
must begin with an equals (=) symbol.

Thus, a formula to add the contents of cells A6 and B6 must be expressed as =A6+B6. 
If you try to type this formula as A6+B6, it will be treated as a label.

Formula Errors

If you try to enter a formula with a logical or mathematical error, Excel will show a message
box stating what error has occurred. To proceed, you must click the OK button. If you want further
information on the error, you can select the Help button, which will provide a broader explanation
of the error. You need only correct the problem to continue.

Another common problem is the circular reference, which is a formula that directly or
indirectly refers back to the same cell in which it resides. For example, if you tried to enter the
formula =A12+B12 into cell B12, an error box will appear stating a circular reference has occurred.
This is because cell B12 is an operand in the operation, as well as the cell that holds the result of the
calculation. 

^ Exponentiation

*, / Multiplication, Division

+,– Addition, Subtraction

% Percent (i.e. 75% represents 0.75)
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Absolute and Relative Addressing

Suppose we want to make our worksheet more flexible for future changes. The professor
may decide that the quiz should only contribute 10% toward the final grade and the midterm 40%.
In that case, the formula for the final grade must be adjusted to change the percentage weight applied
to the midterm and quiz.

You could, of course, re-enter the new formulas, but an easier way to keep track of the
percentage weight assigned to each grade would be to list the percentages assigned to each grade in
an unused portion of the spreadsheet. Formulas would reference the cell addresses where these
percentages reside rather than the percentages themselves. 

Set up an Assumptions section in the upper left-hand corner of your worksheet. Move the
course list down so that the column labels are in row 14. Enter the label “Assumptions” in cell A7
and enter underlining in cell A8. Below that, in cells A9 through A11, enter the labels “Quiz,”
“Midterm,” and “Final Exam.” In cells B9 through B11, you would enter the percentage weights for
each of these grades.

You could then develop a formula to reference the cells where these percentages resided
rather than use the percentages themselves. The formula for James Jackson’s grade (which should be
entered in cell E16 since the worksheet was moved down) would then be:

=B16*$B$9+C16*$B$10+D16*$B$11

The $ designates an absolute address. An absolute address is one that will not change 
when that address is copied. Excel’s default is to treat an address as a relative address, meaning that
when you copy or move a formula, the addresses of the cells in the formula will be automatically
adjusted to fit the new location. A relative address has no $ symbols. Any formula with multiple 
cell references can have absolute, relative, and mixed addresses (see the next section) all in the one
formula.

In other words, if you copied the formula in cell E16 for James Jackson’s grade to cell E17
for Paul Parker, the formula in E17 would automatically adjust to add the proper cell addresses 
for Parker’s grade. The formula bar would show the formula in E17 to be
=B17*$B$9+C17*$B$10+D17$B$11.

Mixed Addressing

There will be certain situations where you will want to combine relative and absolute
addressing; that is, create a cell reference that is part relative and part absolute. Either the column
letter or the row number remains constant.

For example, an address of $B21 means that absolute addressing will be used on the column
portion of the address, but relative addressing will be used on the row portion. Conversely, an address
of B$21 means that absolute addressing will be used on the row portion of the address, and relative
addressing on the column portion. You will need to use relative, absolute, and mixed addressing
throughout your Solve it! Spreadsheet Cases.



Formatting

Suppose you want to express the percentages in your Assumptions section as 50% rather
than .5. You can change the format in which numeric information appears by using Excel’s
Format/Cells commands.

First, select the cells you want to change by selecting the range B9:B11.

The Format/Cells command activates the Format Cells dialog box, as explained in the
tutorial for Spreadsheet Case 1. This box has six formatting tabs: Number, Alignment, Font, Border,
Patterns, and Protection. To change the format of numbers, select Number. Do this by clicking on
the tab label at the top of the box. The Format Category list is divided into the different types of
numerical appearance. Select Percentage with zero decimal places and press the OK button.

You should see the effects of this formatting on the three figures in the Assumptions area of
the worksheet. They will be displayed as percentage figures: 15%, 35%, and 50%. Excel often
provides shortcuts to frequently used commands and operations by allocating buttons on Toolbars.
In this case, Excel has placed a Percent Style button on the Formatting Toolbar. To format the current
cell(s) in a Percent Style, simply press the Percent Style button:

The different Number categories are:

General format is the default format for all new worksheets. With the General format, the
values are displayed in their natural state. No suppression or compression of formatting is permitted.
Scientific notation will be used to display numbers that are too large or too small to be displayed
normally. The General format displays up to 11 digits.

Number format displays a fixed number of decimal places, negative values in red, negative
values in brackets, and combinations of these characteristics.

Currency format places a dollar sign before each number and uses commas to separate
hundreds from thousands, etc. There are options for zero or two decimal places, and for red or black
negative values.

Accounting format displays four accounting formats, keeping the dollar sign to the left of
the cell, showing negative values in brackets, and displaying zero values as hyphens.

Date format displays dates in a variety of different ways and can be used by Excel in
mathematical calculations. Default date formats include:

d/mm/yy (Example 2/02/80)

d-mmm-yy (Example 2-Feb-80)

d-mmm (Example 2-Feb)

mmm-yy (Example Feb-80)
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To use date and time formats, you must use one of the Excel date and time functions 
(such as =DATE, =DATEVALUE, =TIME, =TIMEVALUE, or =NOW) to enter dates and times into
your worksheet. Excel date functions will be treated in more detail in Spreadsheet Case 8. A date can
also be entered as a label if it is not involved in any calculations.

Time format can represent times in a number of formats where they can be used by Excel
time functions in mathematical calculations. 

Percentage format displays numbers as percentages. The number of decimal places in the
default formats are zero and two.

Fraction format displays numbers as fractions, separating whole numbers and the frac-
tional parts.

Scientific format displays data in exponential scientific notation.

Text format displays the values as labels rather than values.

Special format displays zip codes, zip codes + 4, phone numbers, and social security
numbers.

Custom format can be used to create custom formats for numbers such as product codes.

After you have finished formatting, calculating final grades, and adding a column heading
for FINAL GRADE, your worksheet should look like Figure 3-3.

Figure 3-3



Totalling the Values in a Range

This case requires totals of of the aggregate number of Visitors, Shoppers, Attempted Buys,
and buyers. The =SUM function of your spreadsheet software can help you do this. The =SUM 
function calculates the sum of all of the values in a specified range. The form of the =SUM function
is:

=SUM(range)

For example, if you want to total the percentages in the Assumptions section of your sample
worksheet to make sure they add up to 100 percent, you could use the =SUM function instead of the
formula =B9+B10+B11. The values in range B9:B11 can be totalled much more easily by entering
in cell B12:

=SUM(B9:B11)

Excel provides a shortcut for this formula: the Sum Button .

This button appears on the Standard Toolbar, and if pressed, the =SUM formula will be
placed in the current cell and a sample range will be assumed, typically above or to the left of the
current cell. All you have to do is press ENTER to complete the operation. Try the button as well as
entering the formula yourself. When entering the formula, select the range B9:B11 using the cursor
keys or the mouse rather than typing the range. This tends to be easier and more accurate; typing is
more prone to error.

Save Course.xls with the changes you made during this tutorial session. You will need it for
subsequent Spreadsheet Cases.
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Spreadsheet Case 3

The Confidential Executive Payroll

Problem: Develop a payroll register

Management skills: Organizing

Excel skills: Formulas
Absolute and relative addressing

File: EFFICIENT_Q.XLS

Efficient Machining is a leading producer of machine tools with 12,000 employees and an
operating budget of $1,000,000,000. All employees except the ten members of the corporation’s
executive steering committee are on the firm’s automated payroll system. The executive steering
committee consists of the ten top managers of the firm, including the CEO. It has a separate
confidential payroll, which is processed manually because it contains highly sensitive information,
such as senior management salaries and bonuses. The executive committee, like other salaried
employees, is paid monthly.

Emily Hiltman, executive secretary to the CEO, is in charge of preparing the confidential
executive payroll. She must make all of the calculations for salary changes, deductions, and net pay
using a hand-held calculator. She then types the results onto a Payroll Register sheet. A Payroll
Register is a report prepared for each payroll period that lists the names, gross pay, deductions, and
net pay of all employees, and the total gross pay, deductions, and net pay for that payroll period.
Emily writes out the checks by hand.

This is a very time-consuming process, which prevents Emily from fulfilling other
responsibilities. Her boss, the CEO, would like to use her time more productively for scheduling
meetings and filtering correspondence. Also, there is a danger of miscalculations, which would incite
the wrath of senior managers. Emily and the CEO would like to automate the process as much as
possible while maintaining strict confidentiality.

Emily feels there are so few checks to write that this part of the process could remain
manual. However, many hours could be saved if all of the payroll calculations and the preparation of
the Payroll Register report could be automated.

From your data diskette, load EFFICIENT_Q.XLS, which displays the names of the
executive steering committee members, social security numbers, and annual salaries. You should
develop a worksheet that creates a Payroll Register report for the executive steering committee. 
The worksheet should automatically calculate monthly gross pay, net pay, and all deductions. 
It should also provide totals for each of these categories for the pay period.

Monthly gross pay can be computed by dividing annual salary by 12. Federal withholding
tax should be set to 28% of gross pay. State withholding tax should be set to 8% of gross pay. 



For the tax year 2003, FICA (the employee Social Security deduction) is 6.2% of the first $87,000
earned during the year. The Medicare deduction is 1.45% of gross pay for all wages earned during
the tax year. Since this is the first pay period of 2003, FICA and Medicare deductions must be taken
for all members of the executive committee for this payroll. Group health insurance is $100 per
month. All executive steering committee members have elected a stock option plan, which deducts
7% of gross pay each month to purchase shares of the corporation’s stock at a discount.

Tasks

There are 5 tasks to this problem:

1. Complete the column labels to include gross pay, all deductions, and net pay.

2. Make all appropriate format changes for numbers and percentages. Columns containing
numbers should be formatted to show two decimal places to the right of the decimal point.

3. Create an assumptions section for all deductions and other variables in the upper-left corner
of the worksheet and label it “Assumptions.” This way, you can easily make changes in
deductions and formulas using the addressing function of spreadsheet software. By keeping
all assumptions in a clearly defined assumptions section, you can make changes rapidly in
the worksheet to respond to changing tax laws or other regulations. Listing variables also
allows all assumptions to be clearly visible and reported.

4. Use formulas to calculate monthly gross pay, all deductions, and net pay. Be sure these
formulas reference the appropriate cells in the assumptions section of your worksheet (e.g.,
$A$56) rather than actual values (e.g., 20%). Provide totals for gross pay, net pay, and each
deduction category so that Emily can track the company’s expenses for the pay period.
Widen columns if necessary.

5. Print the spreadsheet. This sheet should fit onto a single page.

Additional Problems

1. The company has decided to implement a before-tax savings plan. Employees can deduct
8% of their gross pay before taxes to put into this savings plan. Modify the Payroll Register
Worksheet to implement this plan.

2. The company feels it should be withholding 35% of gross pay for federal tax. Modify your
worksheet to change the federal withholding tax deduction and print the new version.

Time Estimates

Expert: 30 minutes

Intermediate: 1 hour

Novice: 1.5 hours

There is no tutorial for this case because it uses skills introduced in earlier chapters.
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Spreadsheet Case 4

Brooks Investment Advisers

Problem: Analyze financial ratios

Management skills: Deciding

Excel skills: Formulas
Spreadsheet control
Reporting

File: BROOKS_Q.XLS

Brooks Investment Advisers (BIA) is a small-investment advising firm that has just opened
in Tacoma, Washington. It is trying to take market share from large brokerage houses by offering
custom advice to clients on long-term investing, rather than recommending the stock-of-the-week
strategy touted by its competitors.

Clients may call or visit to seek expert advice about specific stocks in which they are
interested. Chip Sanders, a prospering attorney, has expressed interest in two firms in the music,
video, and book retail sector, and he wants to know if either one will make for a good investment.
These firms are Barnes & Noble and Borders, both of which are listed on the New York Stock
Exchange.

Barnes & Noble is the nation’s largest bookseller, operating about 800 superstores
throughout 49 states and the District of Columbia, and employing 40,000 under the Barnes & Noble
and B. Dalton names. The company also does business online under the Barnesandnoble.com name,
which since its inception in 1999, has become the world’s sixth largest online e-commerce site. It is
a Fortune 500 company, and for 2002, sales were $5.2 billion.

Borders is the #2 bookstore operator in the United States after Barnes & Noble. Borders
Group has stores in all 50 U.S. states, as well as in the UK, Australia, New Zealand, Puerto Rico,
and Singapore. Its more than 1,200 retail stores include about 435 Borders superstores, about 780 
mall-based Waldenbooks stores, and more than 35 UK-based Books Etc. Like Barnes & Noble,
Borders focuses on both in-store and online sales. Borders’ Web site is run by Amazon.com, the
leading online bookseller in the world. In 2002, sales were $3.4 billion. Both companies offer
common stock.

To make sound recommendations, BIA’s analysts must carefully examine a company’s
financial statements. The purpose of financial statements is to identify the major sources, uses, and
flows of funds within an organization. The three principal financial statements used in business are
income statements, balance sheets, and cash flow statements.

Income statements (also called operating statements) summarize the income, expenses, and
profits of businesses for a specified period. The purpose of income statements is to show the
profitability or unprofitability of firms during a specified period, usually a year, quarter, or month.



Balance sheets identify the assets, liabilities, and owners’ (or shareholders’) equity of a firm
at a particular point in time. The difference between assets and liabilities is net worth or equity (lit-
erally what the organization is worth net of all other factors). Cash flow statements provide detailed
information on total receipts and disbursements of cash. Cash flow statements are like checking
account registers for individuals.

Certain financial ratios based on figures from financial statements have been traditionally
used to assess a company’s financial health and performance. There are five kinds of financial ratios
that you can apply to assess the financial position of a firm.

1. Liquidity Ratios

Various liquidity ratios measure a firm’s liquidity, its ability to draw on cash and other
current assets to pay its financial obligations. Two commonly used liquidity ratios are the current
ratio and the quick ratio, or acid test.

(a) Current Ratio = Current Assets
Current Liabilities

(b) Quick Ratio, or Acid Test = Current assets - Inventory
Current liabilities

The current ratio is the most commonplace measure of short-term solvency. If current
liabilities are rising faster than current assets, this may be a harbinger of financial difficulty. 
The quick ratio measures the firm’s ability to pay off short-term obligations without relying on the
sale of inventory, which is the least liquid of the firm’s current assets.

2. Asset Management Ratios

Another group of ratios measures how effectively a firm is managing its assets. One of these is
the total assets utilization ratio, which measures the utilization or turnover of all of the firm’s assets.

(c) Total assets utilization= Sales
Total assets

3. Debt Management Ratios

These ratios determine the extent to which a firm uses debt financing. If equity, or owner-
supplied funds, accounts for only a small portion of a firm’s total financing, the risks of the firm are
borne mainly by creditors. On the other hand, by raising funds through debt, owners can control the
firm with a smaller investment of their own. If the firm returns more on the borrowed funds than it
pays in interest, the return on the owner’s capital is magnified, or leveraged. An important ratio is the
debt ratio, which measures the percentage of a firm’s total funds provided by creditors. 

(d) Debt ratio = Total liabilities
Total assets
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Creditors prefer low debt ratios, whereas it may be advantageous for owners to seek high-
er debt to leverage their money and earnings. However, a debt ratio that is too high signals trouble
repaying loans and too much reliance on borrowed money to pay for the firm’s operations.

4. Profitability ratios

Profitability ratios illustrate the combined effects of liquidity, asset management, and debt
management on profits. Important profitability ratios measure the return on total assets (ROA), the
return on common equity (ROE), or return on stockholders’ investments, and the profit margin on sales.

(e) Return on Total Assets = Net profit after taxes
(ROA) Total assets

(f) Return on Equity (ROE) = Net profit after taxes
Net worth (equity)

(g) Profit Margin = Net profit after taxes
Sales

5. Market Value ratios

These ratios help indicate what investors think of the company’s past performance and
future prospects. The market value ratios (and stock price) will be high if a firm has strong liquidity,
asset management, debt management, and profitability ratios. The most widely used market value
ratio is the price/earnings ratio.

(h) Price/Earnings Ratio = Price per share
Earnings per share

To evaluate a firm’s financial ratios properly, you must compare the ratios to ratios for
comparable businesses. You can find financial ratio data on comparable businesses in publications
like Dun and Bradstreet’s Industry Norms & Key Business Ratios and Robert Morris’s Annual
Statement Studies. Both publications group businesses by standard industry classification codes and
provide financial ratio data by standard industry classification code.

Tasks

There are five tasks in this case:

1. Examine the 2002 income statements and balance sheets of Barnes & Noble and Borders,
which can be found by loading the file BROOKS.XLS. All data are based on the publicly
available 2002 annual reports of these firms.

2. Print out the financial statements so you have a hard copy to work with. Look at them very
closely. 



4. Assign range names to the income statement data, the balance sheet data, and the area of
the worksheet containing the financial ratios. Create a table of range names below the work-
sheet. Format the ranges with the income statement and balance sheet data to display a
comma with zero decimal places. Format the ranges with the financial ratios, earnings per
share, and stock price to display two decimal places.

5. Calculate the eight financial ratios outlined above for each company at the end of the
financial statements. Print out the ratios for both companies.

6. In a single paragraph, write an analysis of both companies. If possible, find statistics on
financial ratios for comparable businesses using either the Dun and Bradstreet or the Robert
Morris publication. Based on the information provided in this case, is each firm financially
sound? Which would make the better investment? Review the financial statements of both
companies for any items that might help explain their financial position.

Additional Problems

1. Obtain the current stock price for each of these companies and recalculate the
Price/Earnings ratio.

2. Use the Web to search the EDGAR database [www.sec.gov/edgar.shtml] maintained by the
Securities and Exchange Commission. This database contains companies’ quarterly and
annual financial reports, as well as other documents filed with the SEC. Use this informa-
tion to recalculate the financial ratios for both companies. Would that make a difference in
your decision?

Time Estimates

Expert: 45 minutes

Intermediate: 1 hour

Novice: 1.5 hours

Excel Tutorial for Spreadsheet Case 4

You do not need to use range names for the solution to this case, but they can be used if you
wish when you use different formats for different ranges in your worksheet.

In Course.xls, name the range with the student grade data as GRADES. Name the range
with the percentages used in the Assumptions section as PERCENT.

Naming Ranges

You can name a range with the Insert/Name/Define command. To name the range with the
percentages PERCENT, you would do the following: highlight the three cells B9:B11, select Name
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from the Insert menu, and then select Define from the sub-menu. A Define Name dialog box will
appear, already containing the percentage range reference. Type the name PERCENT and click the
OK button.

You can alternatively select Insert/Name/Define, then select the range once within the
dialog box and type the name. Use either procedure to name the range B16:E19 as GRADES.

Creating a Table of Range Names

You can document your range names in a table in your worksheet using the
Insert/Name/Paste command. Place the table in an unused portion of the worksheet where it will
not overlay any data. The spreadsheet design principles introduced in Chapter 2 suggest placing the
range name table below the left-most portion of the worksheet.

To create the range name table, move to the cell where you want the table to appear and select
the Insert/Name/Paste command. A dialog box appears, listing the named ranges. The purpose of this
dialog box is to paste a selected Name in the formula bar. However, we are using the alternative purpose
of the dialog box: pasting a list of range names and their references onto the worksheet. To do this, click
the Paste List button. This will result in a worksheet resembling that in Figure 3-4.

Figure 3-4



Spreadsheet Case 5

The Town of Madras

Problem: Prepare a budget for a small municipality

Management skills: Planning
Deciding

PC skills: Formulas
Spreadsheet control
Reporting

File: MADRAS_Q.XLS

The town of Madras has a population of 5230 and is located in Jefferson County, Oregon.
Each October, Jason Towers, the town manager, works with the Mayor and the Board of Trustees to
develop the town’s budget for the forthcoming year. The town’s main source of revenue is the local
property tax, but it also receives some aid from the state government and some revenue from
miscellaneous licenses and fees.

The town leaders want to hold to their campaign promises of not raising taxes. Their
community has become very environmentally-conscious, and they do not want to encourage new
businesses that would add to the traffic congestion or pollute the air. They fear revenues may be
going down because the state of Oregon is facing severe financial problems and wants to cut the state
aid it provides to local governments. 

Jason Towers wants to develop a budget that can be supported by anticipated revenues.
Anticipating continued cutbacks in state aid, Jason would like to develop preliminary budgets for the
next two years. That way he can plan ahead if major changes are required. If planned expenditures
exceed revenues, Jason, the Mayor, and the Trustees must develop an alternative budget that does
balance. Can they develop a balanced budget without raising local property taxes?

From your data diskette, load the file MADRAS_Q.XLS, showing the actual receipts and
disbursements for the Town of Madras in 2004. Jason wants to use this budget as the basis for
projecting the town budget for the next two years.

One way to analyze a budget is to estimate the amount of each category of cash receipts and
disbursements. The projected outflow of funds is subtracted from the projected inflow. If the amount
of outflow is greater than the amount of inflow, the town must secure additional funds to pay for its
expenditures or reduce its expenditures. For instance, the town could raise taxes or borrow money to
meet its costs, or it could reduce some of its expenses. 

In projecting the next two years’ budgets, the town manager wants to use the following
assumptions. He expects the state will reduce its aid to the town by 15% each year. Historically,
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expenditures for employee benefits have been rising 12% annually. He expects all other expenditures
to rise at a rate of 5% annually and miscellaneous receipts to rise 4% annually. The town’s expendi-
ture for debt service to pay off previous loans will remain constant. Can the town balance its budget
if it keeps its promise not to raise taxes or go further into debt? 

Tasks

There are 5 tasks in this case:

1. Print out and review MADRAS_Q.XLS.

2. Create an assumptions section of the worksheet to identify factors in your calculations of
receipts and disbursements. Make sure formulas reference cells in the assumptions section
wherever possible.

3. Calculate the receipts and disbursements for each of the categories on the worksheet 
for 2004 and 2005. Calculate total receipts and total disbursements. The case has been
simplified so that all revenue is collected in the year it is due.

4. Complete the worksheet by subtracting total receipts from total disbursements in 2004 and
2005. Print the results.

5. Write a brief analysis of the projected 2004 and 2005 budgets for the town of Madras. 
If these budgets don’t balance, what steps would you recommend that the town take? Revise
your worksheet to incorporate your recommendations, save it under another name, and print
it out again. Keep revising the worksheet until you have developed a balanced budget. 
Is there some way for the town to come up with a balanced budget without raising taxes?

Additional Problem

1. What if state aid is not reduced but remains constant for the next two years? What impact
would this have on the budget? Revise your worksheet and save it under a different name.
Print out and analyze the results. 

Time Estimates

Expert: 30 minutes

Intermediate: 1 hour

Novice: 1.5 hours

There is no tutorial for this case because it uses skills introduced in earlier chapters.


